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Before you start ...

Before you start ...
About This Documentation

This documentation applies to version 2017 of the Prinect Maintenance Center software. This manual 
contains all the information that you need to use the Prinect Maintenance Center.

This documentation is aimed at the customer's system administrators. This documentation will be 
applicable once the Prinect Maintenance Center has been successfully installed by the Heidelberg 
customer service.

Typographical conventions

The following typographical conventions are used in this manual:

• References to other chapters and sections are blue and underlined.

Example: Refer to section "Typographical conventions", page 7.

• Quotation marks are used to indicate menus, folders, functions, hardware conditions, switch 
settings, system messages, etc.

Example: Set the switch to "off".

• Menus, functions and sub-functions are separated by ">".

Example: Select "File > Open...".

• A plus sign is used to indicate that several keys have to be pressed simultaneously.

Example: Press Alt+A.
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Before you start ...
Important Information

Important information in the text is indicated by symbols at the side which are used as follows:

Warning: Contains information that must be taken into consideration to protect the user 
from injury.

Attention: Contains information that must be taken into consideration to prevent damage 
to hardware or software.

�

� Note: Contains important general or supplementary information about a specific topic.

Prerequisites: Lists requirements which must be fulfilled before the steps which follow can 
be performed.
8 Version 2017



What's New?

What's New?
What's New in Version 2017?
This chapter provides a brief introduction into the key enhancements and changes to 
Prinect Maintenance Center. The blue links will take you directly to more details on the topics. 

New General Features

• For storage space reasons, the maximum number of simultaneous downloads was limited to 8. 

• The caption of the Info Box ("Help > About Prinect Maintenance Center") now indicates the PMC 
version, the computer name, the port ID, and the IP address of the PMC computer. 

General information about the PMC web user interface 

• Status panel: New status messages: 

· The status panel indicates the point of time PSC responded to the latest query for soft-
ware updates. This applies regardless of whether or not there are update packages for 
the system. 

· The status panel indicates the progress of Service Report generation, see section 
"Context menu of a computer", page 32. 

• Status message section: New status messages:

· When a system upgrade starts, this section indicates the system upgrade that was 
applied. 

Main menu > "Administration" view

• Tab "Outgoing E-Mail": In this tab, you can now select the desired security level of the connec-
tion and the authentication method and, depending on the authentication method, you can 
choose if custom security certificates will be accepted, see section ""Administration" > 
"Outgoing E-Mail"", page 50. 

Main menu > "Computer Inventory" view

In addition to the new "Digital Presses" item, all necessary information about the digital presses con-
nected to your Prinect system are displayed. 

Main menu > "Prinect Supervisor" view 

• When Windows is shut down, the Prinect Supervisor makes sure the Prinect System is properly 
terminated beforehand, see section "Supervisor Behavior When Shutting Down a Windows 
System", page 29. 

Main menu > "Software Update" view 

• The check of user privileges for updates was modified, see section "Checking the User Privileges 
for a Product Update or System Upgrade", page 42. 

• Increased installation performance: Installation also includes the time-consuming transfer of 
update packages to the respective computers. Provided that installation has to be repeated, 
already transferred update packages will remain stored on the respective computers for a cer-
Prinect Maintenance Center  –  User’s Guide  9



What's New?
tain period of time. Following successful installation, the update packages will be deleted on the 
computers in question in order to save space. 

• History icons: The Installer messages are collected for each computer separately during a prod-
uct update or a system upgrade. You can view these by clicking the History icon. See section 
""The following computers will be updated" (update cards)", page 37. 

• The preparatory and follow-up actions appear in the Update tab only if they are really needed. 
If several update packages are available for one product, it is sufficient to trigger the necessary 
preparatory and follow-up actions that may be necessary only once. 

• Navigation pane: Right-clicking a computer in the "Software Update" and "Supervisor" views 
now lets you directly go to the Inventory view of the computer in question. 

• Navigation pane: If an update is available for the Service Tools (ST / STMAC), this has to be 
installed first. This update package will be selected by default in the list of Software Updates and 
cannot be deselected. 

• Navigation pane: With the context menu command "Create service report" you can set up filter 
function parameters (computer selection, date...) for creating a Service Report and download 
the report to your local computer, see section "Context menu of a computer", page 32. 

• "Main pane": The update tabs show the "Start", "Stop", "Activation" and "Deactivation" phases 
that control the Prinect Supervisor, see section ""The following computers will be updated" 
(update cards)", page 37. 

Main menu > "Extras" 

• In the context menu of the "Uploads/Downloads" tab, you can define data transfer priorities. 
This is an advantage if certain downloads are vital for the progress of installation processes. 

• "Loaded Software Updates": This dialog was extended by the "All Packages" tab. This tab dis-
plays all update packages available in the system. 

The status messages were also modified, see section "Menu "Extras" > "Loaded Software 
Updates..."", page 22. 

• New column "License": This column displays the product license status that may be required, 
see section "Menu "Extras" > "Loaded Software Updates..."", page 22. 
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Introduction
Terms Used in Prinect Maintenance Center

The section below explains the terms that are important for working with the 
Prinect Maintenance Center. 

Update

An update can be a product update or a system upgrade. The term "update" is used to describe both 
actions.

Update group

An Update group represents a system where all the software components that can be installed are 
taken into consideration. Update groups can be extended with individual computers. During a soft-
ware update, the additional individual computers will then be updated together with the computers 
in the system. This can be required for a stand-alone software such as Prinect Signa Station, which 
is installed on a computer that is not part of a system, but which is still to be updated together with 
this system.

Any computers that were added can be removed again from an update group, but this is not possible 
for internal system computers. 

The color of the computer icons differs, depending on whether or not the computers are members of 
the system group, see section "Description of the icons used", page 30. 

Update package

In addition to the executable installation files, each update package includes a description file with a 
specific update description. It gives the name of the update and which version needs to be installed 
on the customer's network. The package is identified by an acronym which is made up of the short 
name of the software that is to be updated (e.g. "PMC" for Prinect Maintenance Center) and the ver-
sion number of the package (see section "Version number", page 15). 

Computer

Here, a computer is considered as an individual computer in the customer's network. 

Component

The Prinect Supervisor view uses the term "component". In this context, "component" describes the 
various programs (products, services, etc.), that have to be started and stopped on the respective 
computers during updating. 

Customer's network

The customer's network refers to a network of several computers at the customer's site.

Local Information Service (LIS)

The Local Information Service runs on every Heidelberg Prinect Computer (including servers). LIS is 
an application that identifies which Prinect products are installed on the individual computers in the 
customer's network. For this purpose, LIS parses the entries of each of the computers' registration 
Prinect Maintenance Center  –  User’s Guide  11



Introduction
files (Windows Registry or MAC-Info.plist). For each computer, LIS submits a specific list of Prinect 
products along with the product version to Prinect Maintenance Center. LIS is also involved in the 
installation of the update packages by invoking the respective installer. 

Prinect Maintenance Center (PMC)

Prinect Maintenance Center is a network-based application for Heidelberger Software Maintenance 
Contract customers. The main tasks of PMC are to store the update packages and to invoke installa-
tion.

The PMC is connected to every LIS on the customer’s system. Every LIS submits its list of Prinect 
products to the PMC. The PMC merges these computer-specific product lists into an overall product 
list for the customer site. The PMC transfers this overall list and a list of all update packages already 
contained in the PMC Repository (file storage) to the PSC (Prinect Software Center, see below) where 
they are evaluated.

Based on this list, the versions of the latest update packages available at the PSC are compared to 
those in the PMC Repository. When the PSC has newer versions, the PSC generates a list of install-
able update packages and returns this list to the PMC. The update packages in question are now 
transferred from the PSC Repository to the PMC Repository and are ready for installation at the PMC.

A selection of update packages to be installed is suggested automatically. The administrator can cus-
tomize the selection of product updates. The customer always starts the installation manually so the 
customer has full control over any software updates on the customer's network at all times.

Caution: If the PMC is not installed on a separate server, please refer to section "PMC 
Reboot Mode", page 70.

Prinect Remote Update

Prinect Remote Update comprises several software components some of which are installed in the 
Heidelberger network, and some in the customer's network.

Prinect Site ID

This is the individual identification number for the customer's site.

Prinect Software Center (PSC)

The Prinect Software Center is a database-driven application which is used to manage the update 
packages and the access data. The main purpose of the PSC is to qualify and distribute the update 
packages to the customer's network. 

Prinect Supervisor

The Prinect Supervisor is a software application for centralized starting and shutting down running 
programs on all linked computers in a Prinect system. This applies to all running Prinect programs 
and a small number of programs on which Prinect programs depend. The software operates accord-
ing to the master-slave principle. The Supervisor Master and the Prinect Integration Manager are 
always installed on the same computer, the Supervisor Slaves on all the other computers of the sys-
tem. To perform an update, the PMC will communicate with the Supervisor Master and transfer all 
required information, including information about the computers in the system that are affected by 
the update. The Supervisor Master controls the Supervisor Slaves of the computers to be updated so 
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Introduction
that preparation and cleanup of the installations occurs automatically. This means that local interac-
tion is not necessary in order to start and stop software on a computer because the Supervisor Master 
provides exclusive central control. 

Product Update 

A product update is an update where the base and target version of one or several products have the 
same master version. The first three digits (YY.U) of the version number identify the master version 
(see Version number). These are the first two digits of the year version (block 1) and the first digit of 
the subversion (block 2). Compared with a system upgrade, a product update is a frequent, simple 
process during which few products are updated. 

Cross dependency

A Cross dependency exists if proper functioning of a Prinect product in the Workflow System not only 
depends on its own version but also on the versions of other Prinect products it cooperates with. 
Therefore, it is often not possible to install update packages individually. If there are any cross depen-
dencies, the required update package must be installed in a set of packages. 

Prinect Remote Update checks the cross dependencies automatically and provides sets of update 
packages that function in conjunction with one another.

Repository

A repository is a data storage facility. There is one repository each in the Heidelberg Network (PSC) 
and in the customer's network (PMC). 

Service Tools

See section "Local Information Service (LIS)", page 11. 
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System

A system is a network of several computers. The software components of a Prinect workflow system 
are generally installed and distributed among several computers. Therefore, when updating the soft-
ware, the entire workflow system must always be taken into account, not just the individual software 
components. Correspondingly, all of the computers must be seen as a system on which software 
components of a workflow system are installed.

When one of a system’s software components is to be updated, all of the cross dependencies with 
the versions of the system’s other software components are considered automatically. This means 
that, in general, several components of the system must be updated, rather than just one.

System Upgrade 

A System Upgrade is an update where the base and the target version differ with regard to the master 
version. The first three digits (YY.U) of the version number identify the master version (see Version 
number). These are the first two digits of the year version (block 1) and the first digit of the subversion 
(block 2). 

Compared to a product update, a system upgrade is a very complex and rather rare process that usu-
ally takes place once a year. In contrast to a product update of individual products, a system upgrade 
raises a great number of products to a higher version is a single concentrated action. 

Connection

There are different types of connections for transferring data: the Heidelberg Remote Service connec-
tion, and the download connection.

Please refer to chapter "Prinect Remote Update - Why?", page 53 regarding this subject.

Heidelberg Remote Service connection

This connection is intended for small amounts of sensitive data. This connection is used to transfer 
customer data (also the Prinect Site ID) and a list of Prinect products and their versions installed in 
the customer's network.

Download connection

The large data volumes required for the update packages are transferred via the download connec-
tion.

Version

A Version identifies how up-to-date a software component or an update package is.

Basic version

This is the version the product had when it was first installed. In a Windows environment, this version 
would be indicated, for example, in "Control Panel > Programs" where you can install and uninstall 
programs. 

Minimum version

This is the version that needs to be installed so that an update can be applied.

Previous version

This is the current version installed before updating takes place.
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Current version

This is the version that is currently installed on the computer or the version after an update.

Version number

Each version number is made up of 4 blocks of numbers, separated from one another with dots. Here 
is an example of a version number: 11.50.463.8 

• Block 1: A two-digit number identifies the Prinect Master version or Year version of a Prinect 
product. For example, "11" is the annual version 11. 

• Block 2: A two-digit number identifies the Prinect minor release. In this context, the tens digit 
identifies the minor release, the ones digit the ServicePack/ServiceRelease version. For 
example, "50” is the minor release "5” and the service pack / service release version "0" (i.e. 
none). 

• Block 3: The Build number has a maximum of 5 digits. It steadily increases within the minor 
release version, but it can jump, i.e. the increment can be larger than 1. For example, "463" 
within the minor release "5". 

• Block 4: The Sub Build number has a maximum of 5 digits. It steadily increases within the minor 
release version, but it can jump, i.e. the increment can be larger than 1. For example "8" within 
the build number "463".
Prinect Maintenance Center  –  User’s Guide 15
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An overview of the procedure
This chapter summarizes the sequence of an update (refer to the diagram below).

1. The PMC generates two lists: a list of all installed Prinect products at the customer site and their 
respective versions, and a list of all update packages already downloaded. These lists are trans-
ferred to the PSC via the Heidelberg Remote Service connection. This transfer takes place once 
a day at a time that can be set, but it can also be initiated manually at any time. 

2. The PSC Repository stores all qualified update packages. Using the two lists mentioned above, 
the PSC creates a list of the new update packages that must be transferred. 

3. The PSC transfers this list to the PMC via the Heidelberg Remote Service connection. 

4. After receiving the list, the download of the update packages is started on the PMC. They are 
downloaded automatically and in the background. 

5. The PMC immediately displays each successfully downloaded update package in "Extras > 
Loaded Software Updates". The update package appears in "Software Update" or is offered for 
installation only if all other required update packages are also available in the PMC Repository. 

6. On the PMC, the customer decides in the "Software update" view which updates will be 
installed. All packages which bring the customer's network up-to-date are selected by default. A 
manual selection of product updates (except PMC and ServiceTools) is also possible. The instal-
lation is always started manually by the customer.

Checking the PMC User Privileges
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To access the PMC, you have to identify yourself as an authorized user. The following prerequisites 
apply:

• the user must have local access to the computer on which the PMC is installed. 

• He/she must be a member of the group of administrators on the PMC computer.

Authentication in the network: 

the login dialog detects automatically if the PMC computer is part of a network domain. If a network 
domain is detected, the domain name automatically appears below the password field.

When a user name is entered without explicitly specifying a domain, the authentication is automati-
cally linked to the network domain. 

A local user to be used for authentication must be specified explicitly. In this case, ".\" must precede 
the user name.

If a user of another network domain is to be used, the network domain must precede the user name 
in the format "Name\".
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Web User Interface
Structure of the Web User Interface

The user interface of the Prinect Maintenance Center consists of four static and two dynamic ele-
ments. The static elements are always visible while the dynamic elements can change their appear-
ance and contents depending on which view has been selected. In the PMC you have the option to 
change the size of the individual elements.

Web user interface of the Prinect Maintenance Center 
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User interface elements 

• static: the menu bar (1), refer to the description in section "Menu "Program" > "Restart"", page 
22.

• static: the view bar (2); you change the dynamic elements (3) and (4) by selecting the views 
below: 

"Prinect Supervisor", see section "Menu > "View" > "Prinect Supervisor"", page 26. 

Indicates that at least one supervisor starts or stops the components. There is not a sin-
gle supervisor where the components are not running or that cannot be reached. 

Indicates that the components of at least one supervisor are not running or that at least 
one supervisor cannot be reached. 

"Software Update", see section "Menu > "View" > "Software Update"", page 30. 

Indicates that new update packages are available and a software update is pending, see 
also "Software Update". 

"Computer Inventory", see section "Menu > "View" > "Computer Inventory"", page 43 

"Administration", see section "Menu > "View" > "Administration"", page 45. 

Is shown if an update for the PMC is available, or if the PMC computer needs to be 
rebooted.

• dynamic: the navigation pane (3) is for the selection and/or administration of computers, sys-
tems and update groups. This area does not appear in the "Administration" view.

• dynamic: the main pane (4) is used for several purposes. In the "Administration" view, the con-
nection settings are made and the computer is connected to the PMC. In the "Computer Inven-
tory" view the main pane displays the inventory for the selected computers/systems. In the main 
pane of the "Software Update" view, the software update is controlled. In the "Prinect Supervi-
sor" view you can control the starting and stopping of software on all computers of a selected 
system. 
On the top right of the main pane you can find two icons for changing the size of the main pane: 
To make the main pane bigger and to hide the navigation pane (3), click the  icon. To hide 
the main pane, click the  icon. To return to the standard view in both cases, click on the  
icon.
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• static: the status message area (5) displays information on current processes. This includes 
messages which are sent to the PMC by running installers or error messages, warnings and sta-
tus messages. 

If you enabled "Show Errors Only" and highlighted a row with an error, the highlighted row 
remains in the visible pane when you disable the option again. 

• static: the status line (6) displays the computer name with Port ID, Prinect Site ID, connection 
status and available hard disk space. When data is transferred, the status line also displays a 
progress bar. See also section "Check hard disk space of the PMC repository before update 
download", page 46. 
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Menu "Program" > "Restart" 
To restart the PMC, click on this command. A message is displayed. After you have confirmed the 
restart, the login dialog is displayed.

Menu "Program" > "Logout" 

Click on this command to log out. The PMC restarts automatically with the login dialog.

Menu "Extras" > "Search for New Software 
Updates"

Usually, searching for software updates is automatically carried out daily at a freely definable time 
(see section ""Administration" > "HEIDELBERG Connection" tab", page 45) in the background. Via the 
"Looking for new software updates" command the administrator can trigger the procedure described 
manually. This will start a new query for the PSC.

After downloading, the update packs (if there are any) can be found in "Software Update". 

See also section "Check hard disk space of the PMC repository before update download", page 46. 

Menu "Extras" > "Loaded Software Updates..."

In this window you can see all update packages of the entire customer's system, including packages 
which have already been installed and those which are currently available for installation. 

• "Product Updates" tab: Update packages installed during product updates or that are available 
for installation. 

Status of Update Packages (in All Tabs)
 

The Update Package is available and can be applied.

 

The Update Package was withdrawn and cannot be applied. 

 

The Update Package is not required and can be deleted. 
22 Version 2017



Web User Interface
The priority of update packages that can be installed ranges from "Normal" and "High" (strongly 
recommended for installation, as the system will shut down otherwise) to "Urgent" (corrects 
security-relevant errors and/or company-critical errors).

You can sort the update packages by any column, by clicking on the arrows or columns. You can 
change the column position by dragging-and-dropping the column header to the position you 
want. You can also use the filter to look for specific update packages by entering text into the 
search field. Please note that the search text entered may also be outside of the area that is cur-
rently visible in a column. 

In the lower part of the window you can find the "Description" and "Hints for the Administrator" 
fields. When you select an update the corresponding information will appear in these fields. This 
can be useful if the information is too long to  be displayed in the corresponding columns.

• “System Upgrades” tab:

Status of System Upgrades 
 

The system upgrade can be applied. All corresponding update packages have been 
downloaded. 

 

The system upgrade cannot be applied. Not all corresponding update packages have 
been loaded yet. 

The upper section displays the system upgrades. A system upgrade can be applied only if all cor-
responding update packages have been downloaded.

The lower pane displays detailed information about the update packages for the selected system 
upgrade. See above for an explanation of the icons. 

• Tab "All Packages": This tab displays all update packages available in the system. See above for 
an explanation of the icons. 

�

� Note: You can delete update packages in any of the three tabs. In the "System Upgrades" 
tab, only those update packages can be deleted that are assigned to the respective System 
Upgrade. Before deletion is carried out, the update packages to delete are listed along with 
their sizes. You have to confirm the deletion of the update packages. 

 

The Update Package was not tested by the PSC and is rated as unknown. This 
applies, for example, to packages locally imported per hotfolder.

 

The Update Package has not (yet) been downloaded completely.

 

The Update Package has been scheduled already and will be downloaded soon. 

 

The Update Package is currently being downloaded. 
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Menu > "Extras" > "Data Transfers..."

The "Uploads/Downloads" tab displays all the update packages that are currently being downloaded. 
Once the download is complete, its entry disappears from this window and appears in the list "Down-
loaded software updates." 

You can set data transfer priorities in the context menu. This is an advantage if certain downloads are 
vital for the progress of installation processes. 

Icons in the "Uploads/Downloads" tab
 

The data transfer is in progress. 

 

The data transfer is scheduled and waiting. 

 

The data transfer is paused due to a temporary error, e.g. if the PSC server cannot be 
reached. 

 

Only very briefly visible. If a temporary error lasts for too long, it will be categorized as 
a permanent error and the download will be removed from this window immediately. 

 

Only very briefly visible. The data transfer finished successfully. The download will be 
removed from this window immediately. 

 

All data transfers are cancelled, and all items in the "Uploads/Downloads" tab are being 
removed. 

�

� Note: On the status line you can also see the download status in the form of a progress bar. 

The "Log" tab provides information about the data transfer. 
I

Icons in the "Log" tab
 

The view is updated. 

 

The view is deleted. 

Menus "Language" and "Help"

• "Language": Use this menu item to find the language setup for the web user interface.
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• "Help": Use this menu item to find the Online Help and program and licensing details. 
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 Menu > "View" > "Prinect Supervisor" 
You will find a description of the term "Prinect Supervisor" in section "Prinect Supervisor", page 12. 
In the "Prinect Supervisor" view you can manually control the starting and stopping of Prinect soft-
ware on all computers of a system. 

"Prinect Supervisor" > Navigation pane 

Except for two differences, the navigation pane to the left (see the screenshot below) looks the same 
as in the "Software Update" view. All systems and computers are listed here. One difference is that 
only those computers can be selected that are running a Supervisor Master. One of the icons below 
displays to the right of your name. All other computers running the Supervisor slave cannot be 
selected. This makes sure that control always occurs centrally and as intended via the Supervisor 
Master. 

Navigation pane

The other difference is that status icons relevant  only in the Supervisor view appear to the right of 
the computers. The possible status icons are explained below:

Everything OK. The Prinect Supervisor is running, the system has been started. 

The Prinect Supervisor is running. The system status is one of the following:

• The system has been shut down.

• Starting or stopping a component has failed.

• Only some of the components are running.

The tooltip of the status icon indicates, which of these alternatives applies.

Almost all components have been started. Only on the "Application Processes" level are 
some of the components not started  

The system is currently being started. 

The system is currently being shut down. 
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You can shut down or restart single computers using the context-sensitive menu in the navigation 
pane. 

"Prinect Supervisor" > Main pane 

Select the computer of a system running a Prinect Supervisor Master in the navigation pane on the 
left. With the Supervisor Master, you control the starting and stopping of all components of the 
selected system (explanation of the term "component" see section "Component", page 11.) 

You operate the Supervisor on the selected computer using the user interface in the main pane. 

• Button Bar: 
Button "Start": All licensed components are started (not the unlicensed ones!). 
"Stop" button: All components are stopped.
"Restart" button All components are first stopped and then restarted.
"Cancel" button: The start or stop process currently running is aborted. 

You can start, stop or restart single components using the context-sensitive menu.

Confirm dialog when starting and stopping components with the following options:

· "Stop Prinect components on 'Database' level as well" or 
"Restart Prinect components on 'Database' level as well": 
When stopping or restarting the whole system, the system by default shuts down or 
restarts only to the Database level. You must set the relevant option above if the whole 
system including the Database level is to be shut down or restarted. 

· "Shut down computer" or
"Restart computer": If the respective option is enabled, Windows will be shut down or 
rebooted on all computers after the components have been stopped.

 

The progress bar next to the button bar indicates the ratio of 
the number of started components (green) to all components 
not yet started (red). The tooltip shows the precise number in 
each case.

 

Use this icon to go to a dialog where you can select which col-
umns will display. 

 

Clicking this icon will display the original column selection and 
reset the table layout.

•

• "Hide Unlicensed Components": Use this option to hide components whose status is "unli-
censed". 

The Prinect Supervisor is not available. This situation can arise if, for example, a new 
version of the Prinect Supervisor is being installed. 
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• List of components: In the center of the main pane, you see a list of all components of the 
selected system. 

Explanation of Some Columns 

"Computer" Name of the computer where the component is installed.

"Name" Name of the component. 

"Type" Internal type designation of the component. 

"Level" Every component is assigned to a so-called level. The level controls the 
sequence when components are started and stopped. 

• As a rule, a selection of components of a level is stopped and started. The 
selection is highlighted red. Exception: Components of the "Application-
Processes" level can be started an stopped individually. 

• Stopping: 
The components with the highest level are at the bottom of the list of com-
ponents. 
A selected component is to be stopped. If there are components with a 
higher level that are subject to the selected component, these compo-
nents are stopped first. Only after that are all the components on the level 
of the selected component stopped if they are subject to this component. 

• Starting: 
The components with the lowest level are at the top of the list of compo-
nents. 
A selected component is to be started. If there are components with a 
lower level that are subject to the selected component, these components 
are started first. Only after that are all the components on the level of the 
selected component started if they are subject to this component. 

"Status" "Stopped": Stopping of the components is finished. 
"Failed": The component could not be started or stopped.
"Unlicensed": The component is unlicensed and cannot be used for this rea-
son. 
"Running": The component is running. 

• Status messages: Status messages display in the status message panel (see section "User 
interface elements", page 20) and in the status bar below the list of components. If possible, this 
also shows from which computer a Supervisor action was run. 

• Start the Supervisor in the PMC user interface if this cannot be accessed: if the Supervisor Mas-
ter cannot be accessed, a button appears with which you can try to start the Supervisor service. 
Click the "Start Prinect Supervisor Services" button. 

• Supervisor locked during product update/system upgrade: When a computer is involved in a 
product update or system upgrade, the respective Supervisor must not be operated as this 
would interfere with the product update or system upgrade. This is why you cannot operate the 
Supervisor in this case.
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• Shut down or restart single computers: you can shut down or reboot single computers with the 
context menu in the Navigation pane. 

Supervisor Behavior When Shutting Down a Windows System

The Supervisor will delay the Windows shut-down until Prinect has been shut down safely if a user 
shuts down a Windows system with the Windows command while Prinect is still running. Shutting 
down the computer will take approximately 10 minutes although the Windows user interface disap-
pears right away. 

Shutting down the Master Supervisor computer will shut down all components on all computers 
belonging to the system.

Shutting down a Slave Supervisor computer will shut down only the components on this computer 
and all dependent components on all other computers belonging to the system.
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Menu > "View" > "Software Update"
In this view you will carry out the actual updates. Furthermore, you can manage update groups in this 
view by adding computers to an update group that are independent of the system or by removing 
them. 

Description of the icons used 

Status information from internal system check 
 

Computer (not part of a system). You can recognize these computers from the 
yellow screen.

 

System.

 

Computer in a system with active connection to the PMC. These computers are 
identified by a blue screen. 

 

Computer in a system with a suspended connection to the PMC. On a computer 
which is not allocated to a system this icon has a yellow screen.

 

Computer of a system which is still being checked by the PMC. If the status does 
not change to green after approx. 10 seconds, refer to section "Computer 
Maintenance", page 68. You can also see this icon if the connection has been 
interrupted for a few minutes. 

 

PMC computer in a system with active connection to the PMC. The is the com-
puter on which the PMC is running.

 

Computer hibernating (not active). 

 

Computer battery-operated. No update is possible in battery operation. 

 

Computer (not part of a system) on which an error has occurred. You can see this 
icon in the tab of the computer concerned in the main pane, see section 
"Computer Maintenance", page 68.

 

System in which an error has occurred on one or several computers. You can see 
this icon in the tab of the system concerned in the main pane, see section 
"Computer Maintenance", page 68.

 

Number of the downloaded update packages. 

 

A System Upgrade is available for the system, see section "View in main pane: 
"System Upgrade Available"", page 35. 

Change in status due to user activity 
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The eye indicates that this computer is ready to execute an operation, e.g. a soft-
ware update. This is generally the case when you click a computer on the left of 
the screen and a tab for the computer opens on the right in the main pane. 

The eye is also displayed if somebody accesses the PMC which is running on this 
computer, from a browser running on a different computer. The tooltip for the eye 
displays these computers and the respective browser addresses. 

 

Successful completion of the operation, e.g. a software update.

 

An error occurred during an operation, e.g. a software update. 

Other icons
 

Update package description. You can see this icon in the tab of a computer or 
system in the main pane.

 

Update card: Update history. You can also see this icon in the update card of a 
computer, see also ""The following computers will be updated" (update cards)", 
page 37.

Only the messages generated during installation are displayed for the computer. 
You can select the list of messages with CTRL+A, copy them to the clipboard with 
CTRL+C so that they can be sent later by e-mail, for example. 

 

Update card: Update history. You can see this icon in the update card of a com-
puter if a warning has occurred during updating, see also ""The following 
computers will be updated" (update cards)", page 37. 

 

Update card: Update history. You can see this icon in the update card of a com-
puter if an error has occurred during updating, see also ""The following 
computers will be updated" (update cards)", page 37. 

 

Update card: You can see this icon in the update card of a computer if messages 
for the administrator are available, see also ""The following computers will be 
updated" (update cards)", page 37.
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"Software Update" > Navigation Pane 

You can maintain computers in the navigation area. You can add computers to update groups to 
update them together. 

• "Computer": All the computers listed in "Computer" are standalone computers.

• “System”: All the computers listed in a system are part of this system. 

For the terms "computer" and "system", see also section "Update group", page 11, section 
"Computer", page 11 and section "System", page 14. 

Context menu of a computer 

In the context menu of a computer you have the following options:

• "Show Available Software Updates": Click this menu item to display the update packages that 
are available for this computer or its higher level system in the main pane.

• "Show Inventory": Click this menu item to call up the inventory of this computer in the main 
pane. This will open the "Computer" view, refer to chapter "Menu > "View" > "Computer 
Inventory"", page 43.

• "Remove from Maintenance Center": This means that a computer no longer displays in the nav-
igation pane and is no longer supplied with update packages by the PMC.

You can only remove computers that are not part of a system as such (see "System", page 14). 
These computers have a yellow icon, . The computer on which the PMC is running is an 
exception to this. In other words, this computer may never be removed. 

• "Move": To move a computer into a different update group, click on this menu entry. Select the 
update group to which the computer is to be added. The computer will then appear in the select 
update group. 

• "Verify Login Data": Prior to running a product update or a system upgrade, the login data will 
be verified, possibly for two different user accounts. The product update or system upgrade 
starts only after the correct login data are set. The login data must be correct for all computers 
involved in the product update or system upgrade. This feature lets you verify the login data 
before installation. 

Clicking "Verify Login Data" while the computer is in a system will cause all the computers of 
the system to be verified. If the computer is a standalone computer, only the login data on this 
computer are verified.

Click "Verify Login Data". The "Verify Login Data" dialog appears. In this dialog you can enter a 
user name and password and start the verification. A result displays for each computer in a sys-
tem. "Failed" means that the login data for this computer are not correct. With the button 
"Repeat", you can repeat the verification with different login data. 

See also section "Checking the User Privileges for a Product Update or System Upgrade", page 
42. 
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•  "Add Cockpits to System" / "Remove Cockpits from System": The function is similar to "Move" 
and "Remove from Maintenance Center" but differs as follows: it always adds all the Cockpit cli-
ents (computers where a Cockpit is running) to a system or removes them from there. 

• "Create service report": The service report is used to document and communicate the system sit-
uation in case of PMC software errors. 

You can select the computers to include in the service report in the "Service Report" dialog. If 
you invoke this function from the context menu of a system group computer, all computers of 
this system group will be selected by default. If you invoke this function from the context menu 
of a computer that is not part of the system group, only this computer will be selected by default. 
You cannot start the service report if inaccessible computers (red tag) are selected. 

Only those files that were created or modified after the date in the date field will be taken into 
account. Once the report has been generated successfully, you can download it to your local 
computer with "OK". You can press "Download" to download the latest report archive once 
again. 

A report generation in progress will continue even if you close this dialog with "Close dialog". 

Provided the PMC no longer responds, you can nevertheless use the URL 
"http://PMC_computer:port_number/report" entered in a browser to create a service report (in 
most cases, the port number is 65200). 
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"Software Update" > Main Pane

The view in the main pane changes according to the update status of the selected system/computer. 

 "System Upgrade Available"

"Product Update Available"

A new main version is available that you can install with the System Upgrade function. There are also 
product updates for the currently installed master version. The Navigation Pane identifies a system 
for which a system upgrade is available with the icon . 

Click the button "Start System Upgrade Assistant" to run the wizard if you wish to install the system 
upgrade. See also the video tutorial section System Upgrade. 

You can also install the available product updates only if you want to run the system upgrade later, 
e.g. because of time constraints; see section "View in main pane: "Product Update Available"", page 
36. 

 "System Upgrade Available"

"No product update available"

A new main version is available that you can install with the System Upgrade function. There are no 
product updates for the currently installed master version. The Navigation Pane identifies a system 
for which a system upgrade is available with the icon . 

Click the button "Start System Upgrade Assistant" to run the wizard if you wish to install the system 
upgrade. See also the video tutorial section System Upgrade.

"Product Update Available"

No system upgrade is available because the master version installed currently is the latest master 
version. There are product updates for the currently installed master version. 

See section "View in main pane: "Product Update Available"", page 36. 

"No update available"

No system upgrade is available because the master version installed currently is the latest master 
version. There are no product updates for the currently installed master version. 

See section "View in main pane: "No update available"", page 35.
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View in main pane: "System Upgrade Available" 

In this section, we describe the situation of a new master version being present and a system upgrade 
being available for installation. The main pane displays "System Upgrade Available" in its caption bar 
and the "Start System Upgrade Assistant" button whenever a system upgrade is available. 

At the same time, you can choose whether or not to install product updates that may exist for the cur-
rently installed master version, and either the message "Product Update Available" or "No product 
update available" appears. If product updates are available, you can install these irrespective of the 
system upgrade; see also section "View in main pane: "Product Update Available"", page 36. 

Prerequisites: A license has been imported automatically. 
The license information about the products you purchased is to be processed automatically 
so that manual licensing actions are unnecessary prior to an automatic system upgrade. 
Using a LUX file, the PSC transfers the license information to the PMC automatically that 
processes and submits the processed information to the License Server. An automatic sys-
tem upgrade is possible only if the respective license keys for the new version were trans-
ferred to the License Server and saved there. If errors should occur, please refer to section 
"Automatic License Import", page 71. 

Prerequisites: The following minimum prerequisite for running a system upgrade applies: 
the minimum software versions of all the computers in the selected system group are equal 
to or later than the minimum software version required for the system upgrade.

�

� Note: We recommend terminating all affected Prinect applications and Adobe Acrobat prior 
to starting a product update or system upgrade.

See the video tutorial covering the System Upgrade topic in section System Upgrade. 

View in main pane: "No update available"

This section describes the situation of neither a system upgrade nor a product update being available 
for the system selected in the navigation pane. This means your system is up to date. 

You see the Heidelberg Prinect products installed on the selected system, with installation date, basic 
version and current version (see Basic version and Current version for a description of the terms). The 
version shown refers to the current version if no basic version is entered. Remote update is currently 
not possible for a product if no current version is entered. 

Click the "Refresh view" button to look for recently transferred update packages for the selected com-
puter. The PMC repository is then scanned and the list of update packages refreshed, if needed. You 
will find more important details about this topic in the section ""Refresh View" button", page 40. 
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View in main pane: "Product Update Available" 

This section describes a situation where there is no system upgrade but where new product updates 
are available for the currently installed master version for the system selected in the navigation pane. 
In this case, new update packages are available in the PMC Repository, and you can perform a prod-
uct update. 

To enable you to get started quickly with this topic, we will now give you a brief, general overview of 
the steps to be taken during the installation of update packages. Use the links to go directly to the 
topics that are documented in detail. 

Overview of a Typical Update Procedure
�

� Note: We recommend terminating all affected Prinect applications and Adobe Acrobat prior 
to starting a product update or system upgrade.

(1). If necessary, set up the update group you want (see also section ""Software Update" > 
Navigation Pane", page 32) in the Navigation Pane (section "Update group", page 11). 

(2). In the navigation pane, select the update group or computer you wish to update. 

3. The view in the main pane changes according to the update status of the selected system/com-
puter (section ""Software Update" > Main Pane", page 34). 

In this example, we will assume that more recent software is available and that "Product Update 
Available" can be seen in the main pane. 

Set the "Update system (recommended)" option below "Select Software Updates" (section 
""Update system (recommended)" option", page 36). 

4. Click "Start Installation" (section ""Start Installation" button", page 40). 

5. If installation is successful, the "Start installation" button becomes "Finish process". Click this 
button to complete the update. 

6. After installation, you will see the "No product update available" view in the main pane, with a 
list of all installed products. 

(7). If necessary, click the "Refresh view" button to refresh the list of update packages (section 
""Refresh View" button", page 40). If new installable update packages are available in the PMC 
repository in the meantime, the view in the main pane changes and you will see "Product 
Update Available" again. See item 3. 

"Update system (recommended)" option 

In the list of update packages (see section ""Select Software Updates" (list of update packages)", 
page 37), select the packages you wish to install. You have the following choices: 

• Automatic selection: Set the "Update system (recommended)" option. All of the update pack-
ages that must be installed to bring the entire system up-to-date are selected automatically. As 
this list is sorted in ascending order, by the version to be installed, the selected update packages 
are at the end of the list. 
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• User-defined Selection: Deactivate the "Update system (recommended)" option. Now you can 
manually select a specific version of packages or package sets for a product that, however, need 
not match the latest version available.

As soon as you have made your selection, all the computers affected by the installation together with 
the update packages to be installed display below the list in "The following computers will be 
updated" (see also section ""The following computers will be updated" (update cards)", page 37). 

"Select Software Updates" (list of update packages) 

This list shows you all the update packages that are available in the PMC repository and can be 
installed. The selection is sorted in ascending order by version to be installed, i.e. the latest update 
packages are located at the end of the list. The latest update packages are selected by default if the 
option "Bring system up to date (recommended)" has been enabled. 

At the end of each item in the list, you see an icon  that you can click to view the description of 
the update package. 

�

� Note: The list is accordingly complex if you are running a complex system comprising sev-
eral computers and several software components with mutual cross-dependencies (section 
"Version", page 14). 

If interdependencies are found, the selection will not only include the individual update 
package you wanted but also automatically a set of related update packages. This ensures 
that your software components function at all times. 

Click the "Refresh view" button to look for recently transferred update packages for the selected sys-
tem/computer. The PMC repository is then scanned and the list of update packages refreshed, if 
needed. You will find more important details about this topic in the section ""Refresh View" button", 
page 40. 

See section ""Update system (recommended)" option", page 36 for information about selecting 
update packages. 

�

� Note: If an update is available for the Service Tools (ST / STMAC), this has to be installed. 
This update package will be selected by default in the list of Software Updates and cannot 
be deselected. 

"The following computers will be updated" (update cards) 

The list "The following computers will be updated" shows all computers to be updated according to 
their selection in the list of update packages in so-called update cards. Requirements for minimum 
versions and cross dependencies are considered automatically. 

Each update detail will be described in its own section below. You can expand or collapse each of 
these sections separately or all at once by clicking the header of the update card. The phases "Start", 
"Stop", "Activation" and "Deactivation" control the Prinect Supervisor. 

• "Data transmission": This shows all the update packages that will be transferred from the PMC 
repository to the computer that will be updated. 
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• "Preparation": Preparation of an installation includes running any scripts required and exiting 
user and service applications. 
In addition, the system checks whether the availability of the computer changed during prepa-
ration, see also "Update inactive computers as well", page 38. In this case, you are forced to 
cancel installation or you decide to continue installation with the changed availability. All ver-
sions of the products listed in this section are affected by these preparations. 

• "Installation": This is where you can view a detailed list of the update packages that will be 
installed for each product. 

dividers mark the group of products to update. Provided the update is to be carried out on two 
or more computers of the update group, the products of the respective groups will always be 
installed on all concerned computers. Installation will then run simultaneously on all concerned 
computers, and the progress depends on the group membership of the products. 

• "Postprocessing": Postprocessing of an installation includes running any scripts required and 
starting user and service applications that were exited in the preparation step. The system also 
checks whether the PMC received more recent packages in the meantime, which would require 
installation to be repeated. All versions of the products listed in this section are affected by these 
postprocessing steps. Follow-ups are performed only after a successful installation. 

• "Activation", "Deactivation" (Prinect Supervisor): The phases "Activation" and "Deactivation" are 
present if a Prinect Supervisor is installed on the computer. In the "Deactivation" phase, the Pri-
nect Supervisor will not be started if a reboot was necessary, and all the Prinect components 
remain inactive. In the "Activation" phase, the Prinect Supervisor but none of the Prinect com-
ponents will be started. They are only started in the "Start" phase. 

• "Start", "Stop" (Prinect Supervisor): The "Start" and "Stop" phases are always scheduled on 
those computers on which a Prinect Supervisor Master is present. In the "Start" phase, all the 
Prinect components are started. In the "Stop" phase, only those Prinect components that are 
affected by a computer update are stopped. 

For a description of the icons in the Update Cards, please refer to Other icons. 

Update inactive computers as well

Normally, all the computers of a system to be updated should be active to avoid version inconsisten-
cies (see also "Version", page 14 and ""Select Software Updates" (list of update packages)", page 37). 
In other words, they should be accessible by the PMC. If this is not the case, a warning is shown next 
to the button "Start Installation": 

There are cases where you want to be able to update a system, although some of the computers in 
it are inactive. 

The following prerequisites must be met to avoid version inconsistencies: 

Prerequisites: 
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• The inactive computer must have been active at an earlier point in time, meaning that the PMC 
has a product list of this computer, even if it is older now. This is necessary in order to check any 
interdependencies. 

• The following items are applicable concerning interdependencies:

· A product can be updated if it has no interdependency to another product on an inactive 
computer. 

· A product that is located both on active and inactive computers can be updated. This is 
also the case if the product versions are different on both computers. 

When an inactive computer becomes active at a later stage, it is mandatory to subsequently run any 
available updates. This is prepared automatically for you. When active again, the LIS of the computer 
provides a current product list when an update request is made. This list can then be compared with 
the current version. Following this comparison, the list of update packages (""Select Software 
Updates" (list of update packages)", page 37) automatically shows you all the update packages to be 
installed that are also selected by default. You now only have to click "Start installation". The versions 
of the computer that was inactive are then updated. 

Send Wake on LAN (WoL) on update and keep computer active 

WoL is a method of activating computers out of their hibernation state through a special network 
access. Software updates generally do not run during the main working hours but at night, at week-
ends, off-hours, during the midday break, etc. During these periods it is reckoned that computers are 
not available because they are hibernating. The PMC supports a WoL function to activate computers 
participating in updates through network access and to integrate them into system updates. A com-
puter must support the WoL function and be set up accordingly to be able to use this functionality. 
MAC Books must not be closed. 

�

� Note: The WoL function is disabled by default in new systems. 

Procedure with WoL in the PMC:

• When a computer switches to a hibernation state, it is flagged by the  icon within the PMC. 
An appropriate message is issued in the status messages panel. 

• When a system/computer is displayed in the "Product Update Available" view of the main pane, 
the PMC tries to activate all involved computers out of their hibernation state. It can take some 
time to activate a computer. The icon of the computer goes from hibernation  to active  
when the computer leaves its hibernation state. Update of the computer is possible only after 
the computer was fully activated. 

• An activated computer remains activated while a software update is running or while the related 
system/computer is open in the above-named view.

• A computer, depending on its configuration, returns to its hibernation state when no updates are 
running and the system/computer is not open in the view.

WoL configuration: 
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WoL configuration is done in BIOS on many computers. WoL can be configured separately for LAN 
and WLAN on laptops with LAN and WLAN. Start your computer and set the applicable data in BIOS.

In Windows, you will generally find the settings for WoL in the Network Adapter settings in the Device 
Manager (WoL is a function of the network card). 

Button bar in the main pane / Start installation

"Cancel" button

With this button, you can cancel the actions started with the other two buttons (view refresh and 
installation). Installers already started will not be canceled. 

"Refresh View" button 

When you click "Refresh view", the PMC repository is scanned for new update packages and the list 
of packages in "Select Software Updates" is refreshed. 

�

� Note: Since this is a local operation on the PMC, newer update packages in the PSC repos-
itory may not be included at this point. 

If no update packages are listed, the reason may be as follows: 

• There are no current update packages available for downloading in the PSC. The inventory in the 
PMC Repository is up-to-date.

�

� Note: There are two cases where new update packages cannot be downloaded from the 
PSC to the PMC repository: 
a) You have interrupted your Heidelberg Remote Service connection for a longer period or 
b) the disk space calculated as available after the download is less than 5 GB, see also 
section "Menu "Program" > "Restart"", page 22. In both cases, your computer/system 
would appear up-to-date when compared to the updates in the PMC repository, but would 
appear very out-of-date when compared to the updates in the PSC repository.

• There are newer update packages in the PMC repository. However, they cannot be presented for 
installation because they have interdependencies with other update packages that are not yet 
available in your PMC repository.

If an error dialog appears, refer to section "Data Transfer", page 68.

You can cancel the update by clicking "Cancel". 

"Start Installation" button 

When you click "Start installation", all the update packages that you selected in the list in "Select 
Software Updates" are installed. 

�

� Note: The message "Configuration has become invalid" appears if the availability of a com-
puter changes while an update is in progress. You must then restart the update. 

You can cancel the installation by clicking "Cancel". See below.
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Prerequisite: This user account that is used for the installation must have local administra-
tor rights and must be set up on all of the computers that are affected by the update.
Installation is not possible if a computer is running in battery operation. 

Attention: Follow the instructions in section "PMC Reboot Mode", page 70 if "The computer 
computer_name must be rebooted" warning displays. 

�

� Note: At the beginning and at the end of an installation there will be a message to all cli-
ents.

Start installation

1. Select the update packages you want in the "Select Software Updates" list.

2. Click on the "Start Installation" button. 

A series of consistency checks is now run. This includes whether the computers concerned are 
hibernating, active or battery-operated. 

If there are one or more inconsistencies that make installation impossible, you will see an error 
message about this and you return to the "Software Update" view. If necessary, restart installa-
tion after remedying the error. 

If there are any inactive computers, this will be indicated to you at this point and you can decide 
whether you wish to continue installation nevertheless or prefer to try and activate the comput-
ers first of all. (Does not apply to system upgrades.)

3. Before installation all administrative information about all the update packages to be installed is 
issued.  

You return to the "Software Update" view when you click "Cancel". Installation continues if you 
click "Next". 

4. In the subsequent dialog, enter your user name and your password. The installation will start 
after the authentication. For authentication, please also refer to section "Checking the User 
Privileges for a Product Update or System Upgrade", page 42. 

In "The following computers are being updated" you can see status messages for each computer 
and a progress bar for the installation.

• Successful installation: When the installation has been completed successfully you will see the 
message "The update was successful. Please complete this operation". The "Start installation" 
button becomes "Finish process".

• Faulty or canceled installation: The "Start installation" button becomes "Next". If the installation 
failed, see also section "Installing the Update Packages", page 69. 

5. Installation was either successful or failed.

• Successful installation: Your system/computer is operational again. However, not all processes 
related to installation are finished. 
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Click the "Finish process" button. 

Now, an alignment between the PMC and PSC repositories is performed in order to ensure the 
latest software version is available in the PMC repository. The installed products display in the 
"No product update available" view in the main pane. 

After you finished the process, you can no longer view the installation details in the update cards 
of the computers. 

• Faulty or canceled installation: Click "Next". This triggers postprocessing. 

�

� Note: If a running installation is canceled, the update packages that have already been 
installed will remain installed. The update package currently being installed will finish 
installing. The update will then be canceled. 
If you wanted to install a set of update packages, you run the risk that some of the cross 
dependencies will not yet have been handled at the moment of canceling the installation 
and thus your system may not operate properly. See section "Installing the Update 
Packages", page 69. 

Checking the User Privileges for a Product Update or System Upgrade

You have to authenticate yourself by entering your login data immediately before a Product Update 
or a System Upgrade starts. Installation will start only then. 

As a rule, depending on the components to install, the advanced authentication dialog appears that 
prompts you to specify fundamentally differing login data: 

• First authentication: once again, type the login data required for logging in at the PMC here, see 
also section "Checking the PMC User Privileges", page 16. 

• Second authentication: type the login data of the Prinect user of the computer affected by the 
update. The HD_PRINECT_USER environment variable of the server computers defines the Pri-
nect user name. In this case, the "User name" box is already completed and cannot be edited. 

It can happen in exceptional cases that the HD_PRINECT_USER environment variable is not 
present or is empty. In this case, the "User name" box can be edited, and you have to specify 
the Prinect user here. 

Should the check for PMC user privileges fail, you can also use the function "Verify Login Data" for 
troubleshooting, see section "Context menu of a computer", page 32. 
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Menu > "View" > "Computer Inventory" 
This view shows all the computers (regardless of their current accessibility) at the customer's site that 
currently communicate with the PMC or have communicated with the PMC before, provided they 
were not removed. This information is intended to help you with other administrative duties. In the 
Navigation pane, you can select a computer; its inventory is displayed in the Main pane. For an expla-
nation of the computer icons, please refer to section "Status information from internal system check", 
page 30. 

"Computer Inventory" > "Computers" tab

In this tab you can see all the computers at the customer's site in a flat hierarchy. The icons show the 
difference between the internal system computers (blue) and/or computers that have been added to 
a system (yellow).

"Computer Inventory" > "System" tab

In this tab you can see the computers that were added as well as the systems with internal system 
computers and any computers that have been added (also refer to section "Description of the icons 
used", page 30).

Call up inventory

In both views, you can call up an inventory that displays in the main pane for each computer. 
�

� Note: Please note that parts of the inventory (hardware, network, software, system) are 
updated automatically when they are opened. This query may take a while. 
Please note that the installations of the current day are not yet included in the installation 
history.
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The inventory consists of the following categories: 

• "Database": This has two sections: 

· "Database": This shows you status messages about memory utilization and whether the 
database is a Standard Edition or an Express Edition (limited to 10 GB). 

Memory utilization of the database is OK.

Attention! The memory utilized in the database has exceeded 9216 MB! The 
maximum database size in the Express Edition is 10 GB.

Warning! The database size has exceeded 9728 MB. The maximum database 
size in the Express Edition is 10 GB.

· "Backup": This is where you can view the time and type of the last backup. The "result" 
is a backup return code that is evaluated by the administrator. 

• "Digital Presses": The digital presses connected to your Prinect System are shown here. 

• "Hardware": Here you can find details on the hardware of this computer.

• "Installation history": Here you can find the installation history for all Heidelberg products. The 
latest information can be found on the last page. 

• "Network": Here you can find the network settings of this  computer.

• "Software": Here you can find three sub-categories:

· "Heidelberg products": This is where you can view the Heidelberg Prinect products 
installed on this computer, with installation date, basic version and current version (see 
Basic version and Current version for a description of the terms). The version shown 
refers to the current version if no basic version is entered. Remote update is currently 
not possible for a product if no current version is entered. 
Double-click an item in the table to go directly to its installation history. In this case, the 
product name is used as a filter and consequently only items relating to the product dis-
play. 

· "Heidelberg Hotfix Status": Here you find all Prinect hotfixes installed on a Prinect Server 
(server with installed Prinect Integration Manager). 

· "Other products": This is where you can find other software apart from Heidelberg prod-
ucts that is installed on this computer.

• “System”: Here you can find details on the operating system and the environment variables.

Initially, the categories are closed. The header of the categories shows the time the data on display 
was retrieved.
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Menu > "View" > "Administration" 
In this view you can set the connection to the  Heidelberg Network and test it manually. You can also 
connect the PMC to computers which have not yet been found automatically.

Prerequisite: For the transfer of the update packages an existing Heidelberg Remote Ser-
vice Connection is required. This requires the full and correct entry of the administrative 
data and the Prinect Site ID.

"Administration" > "HEIDELBERG Connection" tab
�

� Note: In this view, you can only edit when the connection to the Heidelberg server is inter-
rupted. See section "Disconnecting the connection", page 47.

To enable the connection, enter your data in "Setting". The following icons appear behind the input 
fields:

 

Your entry is incomplete. As long as this icon appears next to an input field, you 
will not be able to establish a connection. 

 

Your entry is complete. If this icon appears next to all input fields, you can conti-
nue. 

"Prinect Site ID"

The Prinect Site ID is displayed when the license server is available. If this is not the case, refer to 
section "Connection Settings", page 65. 
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"Start Request"

In the selection field "Start Request" you can set the time at which the daily exchange of lists  
between PSC and PMC is to take place. Please note that the subsequent downloading of the update 
packages may take a while and could impact the Internet transfer rate.

Prerequisite: Customer data must be transferred during the update. To take up the con-
nection, you must give your agreement to this. See also section "Prinect Remote Update - 
Why?", page 53. 

�

� Note: Many customers choose a full hour as the time for their daily update requests, some-
thing which can cause peak loads on the PSC. To prevent the performance of the PSC from 
dropping at such times because of too high a workload, the requests have a random delay 
of max. 10 minutes. A message displays in the status messages panel, informing you that a 
software update is scheduled. When the transfer starts, a message displays, informing you 
that transfer was started.

�

� Note: When a request is started, the PMC verifies the time offset between the PMC request 
and the PSC response to this request. A maximum time difference of 25 minutes is set in 
the PMC. The requested update packages are not downloaded from the PSC if the maximum 
time difference should be exceeded, and an appropriate error message is issued in the sta-
tus messages panel. 

Check hard disk space of the PMC repository before update download

The memory space is checked automatically before the update packages are downloaded from the 
PSC to the PMC repository. The PMC is instructed to download by the PSC. Subsequently, the PMC 
checks the required memory space of the PMC repository. 

• Hard disk space below 20 GB: A warning and a warning icon display in the status line if calcu-
lation shows that the expected disk space after the download will be less than 20 GB. Despite 
this, you can still download the update packages to the PMC repository but you must confirm 
the download. 

• Hard disk space below 5 GB: An error message and an error icon display in the status line if cal-
culation shows that the expected disk space after the download will be less than 5 GB. The 
update packages are not downloaded to the PMC repository. 

You can communicate a low disk space also via e-mail, see section "Information about the e-mail 
type "Not enough disk space"", page 51. 

To increase your hard disk space again, you can open the "Loaded Software Updates" dialog with a 
double click and remove update packages that are no longer needed and are tagged by the  icon. 
See also section "Menu "Extras" > "Loaded Software Updates..."", page 22. 

Proxy settings

The PMC must be restarted if the proxy settings are changed. You will automatically be requested to 
do this. 
46 Version 2017



Web User Interface
It is not possible to restart the PMC while a software update is running. An appropriate message dis-
plays. 

Establishing the connection

To establish the connection, proceed as follows: 

1. Statement of agreement: Set the option "I agree that information about my Prinect installation 
will be transmitted to HEIDELBERG."

The "Connect" button is enabled for use.

2. Click "Connect".

Connection status
 

Initial situation: You can now connect. Active connection: The connection was made 
successfully. 

The status display for the connection is updated (refer to the table). If a red icon appears, refer 
to section "Connection Settings", page 65.

When the connection is set up, the data can be transferred automatically and in the background.

The "Disconnect" button is enabled for use. The two options relating to the statement of agree-
ment are disabled. As long as the connection is active, you cannot enter administration data in 
the "Administration > HEIDELBERG Connection" tab. 

"Last Connection Buildup": The time of the latest request for software updates is shown here. A 
red cross indicates that the request was not successful. A green checkmark indicates that the 
latest request was successful. 

Disconnecting the connection

Click the "Disconnect" button to disconnect the connection.

The connection is disconnected. The "Connect" and "Disconnect" buttons are then deactivated. 
The option "I agree that information about my Prinect installation will be transmitted to HEIDEL-
BERG" is no longer activated. This means that by disconnecting you have revoked your 
agreement. 
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�

�

"Administration" > "HEIDELBERG Connection Test" tab

Note: Please note that during a connection test normal requests cannot be made to the 
PSC.

In this tab you can carry out a manual test of the  Remote Service connection and the Download con-
nection. The test includes sending a query to the PSC, downloading a test package and checking the 
entry in the PMC Repository. This test can be useful if it has been detected that the PMC has not 
downloaded any updates from the PSC.

The connection test can be interrupted by the customer, in this case the message "Connection test 
failed!" appears in the status message area. For an error analysis, refer to section "Connection test", 
page 67.

To the right, there are two icons that let you enable or disable automatic scrolling and delete the dis-
played text.

"Administration" > "Computer Connections" tab

The PMC cannot establish an automatic connection to a computer if computer and 
Prinect Maintenance Center are located in different (sub) networks. In this tab you can set up an 
alternative, manual (fixed) connection of these computers to the PMC.

�

� Note: Please note that the Prinect Maintenance Center can only connect to computers on 
which the Windows service "Heidelberg Local Information Service" (from version 13.00.37 
onwards) has been activated. You can check this in "Start > Control Panel > Maintenance 
> Services".
To check this on a Macintosh, open a Shell and run the command sudo launchctl list in it. 
You need administrator privileges to do this. The output has to contain a line containing the 
string com.heidelberg.hdlismonitor and starting with a number (process ID), not with a 
"minus" character. The daemon is not installed if there is no line with such a text. If a line 
containing this text starts with a "minus" character, the Daemon is installed but does not 
run. 

Adding a Computer

The "Computer" window displays all the computers the PMC is currently connected to or the PMC 
was connected to in the past. For these computers, the status "Automatic" is displayed under "Con-
nection". You can extend this list. To add a computer, proceed as follows:

1. Enter the name or the computer's IP address in the field below "Connection".

2. Click on "Manual Connection."

If accessible, the computer is now connected to the PMC. You can see the computer in the list. 
The computer is now also available in the "Software Update" view.
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Connecting a Computer

The "Computer" window also displays all the computers the PMC was connected to in the past but to 
which an automatic connection could not be established at present. For these computers, the status 
"None" is displayed under "Connection". To set up a connection between a computer and the PMC, 
proceed as follows:

1. Select the computer in "Computer".

2. Click on "Automatic Connection".

If the connection was manual before, the computer should now connect to the PMC automati-
cally. Proceed as follows if a connection cannot be established after one minute:

3. Click on "Manual Connection."

If accessible, the computer is now connected to the PMC. You can see the computer in the list. 
The computer is now also available in the "Software Update" view.

Changing a Computer Connection

In the "Computer" window you can see all the computers that were connected automatically or man-
ually. You can change the connection of a computer, e.g. for tests or when a computer cannot be 
accessed. This may occur if the PMC has been installed in a different sub-network. In this case, com-
puters may be marked in red with the status "Manual connection". To change the connection of such 
a computer and the PMC, proceed as follows:

1. Select the computer in "Computer". 

2. In "Connection" click the "Automatic Connection" button.

If accessible, the computer is now connected to the PMC again. You can see the computer in the 
list. The computer is now also available in the "Software Update" view. If this is not the case, 
reset the connection to "Manual Connection". 
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"Administration" > "Outgoing E-Mail"

In this tab, you can set up outgoing e-mails that are triggered by events. For a listed recipient, you 
can set a combination of events that are shown in the screenshot below. A separate e-mail is sent to 
the recipient each time such an event occurs. Sending of the e-mail also displays in the status mes-
sages panel. 

Set up dispatch and recipient 

1. Set the "Outgoing E-Mail" option to "On". 

2. Expand the "Dispatch Settings" section.

3. Make your selection in the "Connection Security" and "Authentication Method" list boxes. 

4. Specify the SMTP Server, the SMTP Port and a correct e-mail address here. 

(5). "Check Server Certificate": Depending on the authentication method, you can choose with this 
option whether or not custom security certificates are accepted. 

(6). Depending on the network configuration, authentication is sometimes required on the SMTP 
server, sometimes not. If necessary, enter the user name and the password. 

7. Use the "Apply" and "Discard" buttons to exit the edit mode and apply or discard the data you 
entered. 

8. Expand the "Addressee" section. 

Specify the addressee and the events to inform the addressee of by e-mail in this section.

9. Click  to create a new recipient. Click  to delete the entry and  to edit the addressee's 
properties. 

When you create and edit the recipient, select the event about which you wish to notify the 
recipient. 

10. Select the language for the e-mail texts.

11. Use the "Apply" and "Discard" buttons to exit the edit mode and apply or discard the data you 
entered. 

To send a test e-mail to a recipient you want, a row with a valid e-mail address must be selected. If 
it is not, the "Test E-Mail" button is dimmed. 
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Information about the e-mail type "Update available" 

Enable the e-mail type "Update available" to inform the recipient of new Prinect software updates 
received in the PMC Repository. 

The "Update available" e-mail type includes the following information: 

Product name
Four-part version number
Priority (High/Normal/Low)
Size in MB
File name

This information displays as follows in the e-mail:

• Prinect Workflow (Version: 13.00.284.4, Priority: High, Size: 98.4MB, 
File: PWF_13.00.284.2.RUP)

• Remote Access (Version: 20.20.10.4, Priority: Normal, Size: 38.2MB, File: RA_20.20.10.4.RUP)

• Common Data Base (Version: 30.30.300.30, Priority: Normal, Size: 130.5MB, File: 
CDA_30.30.300.30.RUP)

�

� Note: E-mail notification is sent only if at least one update package was downloaded suc-
cessfully and is available in the PMC repository. There is no notification with faulty or 
aborted downloads, checksum errors, etc. Such messages display in the status messages 
panel. 

Information about the e-mail type "Not enough disk space" 

The disk space is verified automatically before the update packages are downloaded from the PSC to 
the PMC repository; see also section "Check hard disk space of the PMC repository before update 
download", page 46. 

There will be no automatic downloads if the disk space of the PMC Repository is insufficient. The 
respective message is displayed in the status line. 

You can also enable the e-mail type "Not enough disk space" to communicate this event via e-mail. 
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Data Security
Prinect Remote Update - Why?

Prinect Remote Update ensures that you receive the software updates and hotfixes that 
ensure high productivity and high availability of your Prinect workflow systems quickly and 
efficiently.

Your Prinect software is therefore always up-to-date without any extended downtimes for 
installation and with the planned installation times.

The updates for your specific Prinect workflow system are especially selected, tested and 
made available automatically on your network by Heidelberg.

Up-to-date software versions

The smooth operation of a Prinect workflow system depends – like with every other piece of software 
– on whether the software version being used is up-to-date. Maintaining Prinect customer systems by 
continuously updating the installed software used to be time-consuming. The multitude of different 
product configurations that existed in the field had to be kept up-to-date manually. 

As a result, the improvements and fixes that were developed often took too long to be installed by the 
customer. It was possible for a fault to occur long after the fix had already been developed. Keeping 
the customer systems up-to-date automatically with Prinect Remote Update as a preventive measure 
will enable customers to avoid such faults.

Cross dependencies with other Prinect products

The software components of a Prinect workflow system are generally installed and distributed among 
multiple computers. Accordingly, all of the computers on which the software components of a work-
flow system are installed must be viewed as a cluster or complete system. When updating the soft-
ware, therefore, the entire workflow system must always be taken into account, not just the individual 
software components.

This means that whether a Prinect product functions properly within a workflow system might depend 
on more than just its version alone. It could also depend on the versions of the other Prinect products 
with which it works together. To ensure that the whole system functions properly, all of the depen-
dencies with the versions of other Prinect products are checked and verified for each update package.

Prinect Remote Update automatically checks for cross dependencies and only provides sets of update 
packages for installation that function together properly.

Prinect Remote Update automatically checks daily for any hotfixes and updates for each of 
the installed Prinect products, ensuring that the Prinect workflow system is up-to-date. 
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Prinect Remote Update – How?

When one of a system’s software components should be updated, all of the cross dependencies with 
the versions of the workflow system’s other software components are checked and verified automat-
ically. If any cross dependencies are found, you will not only receive the individual update, you will 
always receive a set of associated update packages. 

Prinect Remote Update is made up of several components, some of which are installed on the Hei-
delberg network, and others on the customer's network. 

The Prinect software components are described below:

Creating the Update Packages

The software used to create update packages runs on the Heidelberg network. In addition to the exe-
cutable installation files, each update package includes a description file with a specific update 
description. 

Prinect Software Center (PSC)

The PSC is running in the Heidelberg network; it is a database-supported application for the admin-
istration of the Prinect Workflow update packages. The primary tasks of the PSC is to verify, admin-
ister and distribute the update packages for the customer’s Prinect workflow system.
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Local Information Service (LIS)

A Local Information Service (LIS) runs on each of the customer’s Prinect workflow system computers, 
whether it is a server or a workstation. LIS is a software that determines which Prinect products are 
installed on the computer. To do this, LIS analyzes the entries in the computer’s registry file. The LIS 
also takes part in the installation of the update packages by downloading them from the PMC and 
invoking the respective installers. 

Prinect Maintenance Center (PMC)

The Prinect Maintenance Center (PMC) is an network-based application for software maintenance 
contract customers that runs on the customer's network. The primary tasks of the PMC are to provide 
and release the Prinect update packages. It automatically suggests a selection of update packages to 
be installed. The customer always starts the installation manually so the customer has full control 
over when the software updates are performed on the customer network.

Connection between the customer and Heidelberg networks

There are two types of connections between the Heidelberg network and the customer network.

1. Heidelberg Remote Service Connection

This connection is intended for small volumes of sensitive data. This includes transferring cus-
tomer data, technical data and product lists for the entire customer site, including version 
details. You find a detailed list of all transferred data at the end of the present description.

2. Download Connection

The large data volumes required for the update packages are transferred via the https download 
connection.

The Update Process

The PMC is connected to every LIS on the customer’s system. Each LIS sends its Prinect product list 
to the PMC, which merges these computer-specific product lists into a full product list for the cus-
tomer's site with details of the installed versions.

This list is then automatically transferred to the PSC once a day at a configurable time, via the Hei-
delberg Remote Service connection. This transfer can also be initiated manually at any other time.
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The PSC Repository stores all installable update packages. The Prinect product versions sent by the 
PMC are compared with the versions in the latest installable update package. If the comparison 
detects that newer versions are installable and they have not been transferred yet, a list of the latest 
installable update packages will be created on the PSC and, sent to the PMC via the Heidelberg 
Remote Service connection.

These packages will then be downloaded from Heidelberg into the PMC repository via the download 
connection, where they remain available for the customer to install.

The customer can then decide when and which update versions to install based on the updates dis-
played in the PMC. All the versions that bring the customer network up-to-date are selected by 
default. However, the selection can also be made manually and changed accordingly. However, only 
those update configurations that will result in a properly functioning Prinect workflow system can be 
selected manually.

Only customers can start the installation on the PMC. This gives them full control of all software 
updates on their network at all times.

Prinect Remote Update – Data Security?

Heidelberg offers the highest standard of security with Remote Update for Prinect products.

Secure connections

Any data transferred between the PMC and PSC always originates from the PMC in the customer’s 
Prinect workflow system. The Maintenance Center is designed so that it only allows contact with the 
PSC.

Internet standard protocol with encryption

The Heidelberg Prinect Remote Update is strictly built around Internet standards that fully encrypt the 
transferred data. This prevents the content of the data transfer from being visible to third parties. All 
of the information exchanged between the customer's network and the Heidelberg network to deter-
mine the required Prinect updates remain protected in this way. The large data volumes for the 
update packages are transferred via a secure https connection.
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The Heidelberg Prinect Software Center - the only transfer 
partner on the network

The Internet destination addresses for the Heidelberg Prinect Software Center are already saved in 
the software upon delivery. The software has been developed in such a way that only these destina-
tions can be contacted for Prinect Remote Update. Both communication partners are uniquely iden-
tified when establishing the connection. The customer's network receives an ID that is unique world-
wide and a password. The Heidelberg Prinect Software Center computers have digital certificates, i.e. 
external certification that these destination addresses are actually those of the Heidelberg Prinect 
Software Center.

The customer is always in control

The Prinect Maintenance Center only contacts the Heidelberg Prinect Software Center when wanted 
and explicitly allowed by the customer. To do this, the customer must first enable the data transfer 
that is disabled by default in the Maintenance Center. This only has to be done once. By enabling the 
data transfer, customers agree that they authorize the data to be transferred between their Prinect 
workflow system and Heidelberg as described above, and that they explicitly authorize Heidelberg to 
use the data to optimize its Prinect workflow system.

Once the customer has enabled the data transfer function, all of the necessary data will be exchanged 
once a day between the customer and the Heidelberg network. The update packages in the PMC 
Repository are then made available for installation and displayed in the Prinect Maintenance Center. 

The customer can disable the data transfer in the Prinect Maintenance Center on the customer's net-
work and thus stop the data exchange immediately. In this case, all the computers managed by the 
PMC in the customer's network no longer participate in the automatic update.

The data transfer is authorized, enabling the Prinect Remote Update service in the "Administration > 
HEIDELBERG Connection > Approval" view in the Prinect Maintenance Center.

Depending on the Prinect software installed, only the data required for the update function is trans-
ferred. No other data is transferred.

IT security – a perpetual challenge

New challenges threaten IT security daily. That is why Heidelberger Druckmaschinen AG employs an 
IT Security Council for all of the security-related issues involving the Remote Service. This council 
tracks current developments and stays up-to-date on security-related matters. Heidelberger Druck-
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maschinen Vertrieb Deutschland GmbH also offers all of its customers in Germany – in addition to 
the security measures taken by Heidelberg itself – a comprehensive array of security products and IT 
services including a highly recommended firewall. Having these installations before the network 
access in customer's operations prevents unauthorized access from the Internet.

Secure Heidelberg network

The Prinect Software Center is within Heidelberg’s secure internal network. Access to the PSC is only 
granted to authorized Heidelberg employees via authorized computers which are connected to the 
Intranet. Direct access from the public Internet is possible only under the certain conditions. Heidel-
berg service technicians can use an active security card to log into the Heidelberg Intranet via the 
Internet. A unique password is generated for each access. It is only valid for this service technician, 
only for one connection and only for a brief time.

Data security and training

Before a service technician is provided a personal user account within the Heidelberg organization 
providing access to the Remote Service, he or she is trained in matters of IT security and must sign a 
non-disclosure agreement. All Heidelberg service technicians work with standardized service PCs 
that are always equipped with up-to-date virus protection and modern security functions by the cen-
tral Heidelberg IT department.
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Prinect Remote Update - What data will be trans-
ferred?

RemoteUpdateRequest-RURequestVersion: Version of the RemoteUpdateRequest speci-
fication forming the basis of this request.

RemoteUpdateRequest-RequestID: Transaction number that the PMC newly 
generates for each request. 
This ID is returned by the PSC in the Remo-
teUpdateResponse.

A higher number is always a newer date!

RemoteUpdateRequest-PrinectSID: The Prinect-Site-ID generated during the 
first installation.

RemoteUpdateRequest-CreationTime: Time the request was created in UTC.
Format (according to ISO-8601): YYYY-MM-
DDTHH:MM:SS    (Ex.: 2012-06-
28T16:40:26)

RemoteUpdateRequest-Country: Country code from operating system. For 
Germany: DE

RemoteUpdateRequest-Timezone: Time zone from operating system. For Ger-
many: CET or CEST

PMCInstallation: Information about the PMC installation.

PMCInstallation-Version: PMC version

PMCInstallation-TimeFirstInstallation: Time of the first PMC installation (on the 
server) in UTC.

Format (according to ISO-8601): YYYY-MM-
DDTHH:MM:SS    (Ex.: 2012-06-
28T16:40:26)

PMCInstallation-Hostname: Computer name of the PSC servers.

HEIResInfo-Country: Customer address - country

HEIResInfo-City: Customer address - city

HEIResInfo-Street: Customer address - street

HEIResInfo-Customer: Customer address - customer name

HEIResInfo-Timezone: Customer address - time zone

KeyInfo-Info: Identification info. Currently a comma-sepa-
rated list of dongle numbers located on the 
customer network.

Format: LSN1, LSN2….
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Workflows: List of workflow paths with associated com-
puters.

Workflows-Workflow: The group of computers (at least one) and 
the Prinect software installed for each com-
puter that belongs to this workflow path.

Workflow-Name: Name of the workflow path as represented 
in the PMC.
The workflow path with the non-assignable 
workstations is given the identifier:  <UNAS-
SIGNED>.

Workflow-Workstation: A computer on which at least one Prinect 
product or one Prinect product component 
is installed.

Workflow-Workstation-Hostname: Name of the computer

Workflow-Workstation-OS: Details on the computer’s platform.

Workflow-Workstation-Product: Remote update capable Prinect product or 
Prinect product component on this worksta-
tion (from none to several).

Workflow-Workstation-Product-ProductID: Product identifier. For ServiceTools: ST.

Workflow-Workstation-Product-Version: Product version.

Workflow-Workstation-Product-XInfo: Installation information for the product.

VolumeInfo: Data related to VBP (node structure identi-
cal with APDKInfo)

APDKInfo: Data related to APDK (node structure identi-
cal with VolumeInfo)

APDKInfo-General-CreationTime_Local: Entry time in PMX in the UTC format (as per 
ISO-8601): YYYY-MM-DDTHH:MM:SS (Ex.: 
2012-06-28T16:40:26)

APDKInfo-General-UTC_TimeOffset: Time offset to 
the UTC time. Format: +-HH:MM

APDKInfo-MaintenanceCenter-Hostname: Name of the computer where the PMC is 
installed.

APDKInfo-MaintenanceCenter-Workflow: The Workflow the PMC belongs to. "Unas-
signed" is displayed here if there is no Work-
flow name. 

APDKInfo-Workstations: List of computers that can supply data. 
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APDKInfo-Workstations-Workstation: Computer that can supply data. 

APDKInfo-Workstations-Workstation-AliveStatus: Indicates the current status of the computer. 
Possible values: DISCONNECTED, 
RESTARTED, ACTIVE, MISSING, LOST_CON-
NECTION, SHUTDOWN, REBOOTING, DIS-
ABLED, SLEEP.

APDKInfo-Workstations-Workstation-Hostname: Name of the computer. 

APDKInfo-Workstations-Workstation-Workflow: The Workflow the PMC belongs to. "Unas-
signed" is displayed here if there is no Work-
flow name. 

APDKInfo-Workstations-VolumeData: Data area.

APDKInfo-Workstations-VolumeData-
CreationTime: 

Time of data query in the UTC format (as per 
ISO-8601): YYYY-MM-DDTHH:MM:SS (Ex.: 
2012-06-28T16:40:26). 

APDKInfo-Workstations-VolumeData-Type: Type of data contents. Possible values at 
<VolumeInfo>: VBP, at APDKInfo: APDK

APDKInfo-Workstations-VolumeData-ProductID: ID of the product supplying the data. 

APDKInfo-Workstations-VolumeData-Version: Version of the product supplying the data.

APDKInfo-Workstations-VolumeData-Data: String with data contents. The contents are 
only written when VBP or APDK is used 
explicitly. The contractually specified pro-
duction volumes are transferred in this case. 

APDKInfo-Workstations-VolumeData-
ConnectionStatus: 

Contains the string describing the connec-
tion status between PMC and the data 
source. 

Repository: Repository of update packages in the PMC 
(from none to several).

Repository-Available: List of software packages available in the 
repository.

Repository-Available-Product: Information on the available software pack-
ages.

Repository-Available-Product-ProductID: Product identifier. For ServiceTools: ST.

Repository-Available-Product-Filename: File name of the package:

Repository-Available-Product-Version: Product version.
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Repository-Available-MediaSet: Information about the available system 
upgrades 

Repository-Available-MediaSet-Name: Name of the system upgrade

Repository-Available-MediaSet-Filename: Name of the file describing the system 
upgrade

Repository-Available-LicSet: Information about the available license files

Repository-Available-LicSet-Name: Name of the license set

Repository-Available-LicSet-Filename: Name of the license set file

Repository-Available-LicSet-Status: Status of license file; valid values are 
"AVAILABLE", UNUSABLE" and "USED"

Repository-Unavailable: List of software packages not available or no 
longer available in the repository (due to 
import errors, etc.).

For the attributes, see: Repository-Avail-
able.

Repository-Unavailable-Product-Filename: File name of the package. 

Repository-Unavailable-MediaSet-Filename: Name of the MediaSet description file. 

Repository-Unavailable-LicSet-Filename: Name of the license file. 

ResourceInfo Information about the resource consump-
tion of the Prinect software. 

LicInfo Information about the license status of the 
Prinect software. 
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Customer's consent to the use of data for the pur-
pose of updating software:
The operational and technical data from the customer's Prinect workflow system is transferred to Hei-
delberg for the purpose of updating the Prinect software. By enabling the "I agree that information 
about my Prinect installation will be transmitted to HEIDELBERG" option in the "Administration > 
HEIDELBERG Connection > Approval" view, customers gives their consent for each connection.

Furthermore, the customer explicitly permits the use of the data for the optimization of their Prinect 
workflow system. If the customer changes his mind in the future and no longer consents to the data 
transfer, the customer will be responsible for disabling the data transfer. The customer then needs to 
disconnect the connection by clicking on the "Disconnect" button in the "Administration > 
HEIDELBERG Connection" view in the Prinect Maintenance Center to stop the transfer.

As of Prinect 2017, a payment schedule for the Prinect Software based on the production volume is 
possible. This applies to the Volume Based Pricing (VBP) and in particular to the Automatic Paper 
Stretch Compensation APDK. Heidelberg offers special contracts and corresponding licenses for both 
functions. A list of daily production volume data for the last 30 days will appear in the fields "VBPInfo-
Workstations-VolumeData-Data:" and "APDKInfo-Workstations-VolumeData-Data:" only if the respec-
tive contracts and licenses have been enabled in the customer system.

In case of VBP, the production volume is defined as the number of renderer outputs (TIFF or plates) 
in square meters per unit of time, in case of APDK as processed TIFF area in square meters per unit 
of time. 

If no license is available, the fields "VBPInfo-Workstations-VolumeData-Data:" and "APDKInfo-Work-
stations-VolumeData-Data:" will not contain any data. All other VBPInfo and APDKInfo fields may hold 
the data mentioned before, depending on whether or not the respective Prinect software components 
are installed. 

The following data is transferred: Error status, Prinect interface type, Prinect interface version, polling 
time, status of Prinect data query, list of production volume data for the last 30 days, current date, 
production volume value, checksum. 
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Error handling

This chapter shows potential fault situations. You can find the recommended fault correction mea-
sures below each problem.

Connection Settings

Settings

The Prinect Site ID is not displayed but the message "Searching for License Server" appears in the 
status line.

Cause: There is no connection to a License Server.

Measure: Please check the License Server. Is the computer switched on? Is the License Mana-
ger running? Is LIS installed?

Status

The connection cannot be established: After clicking on the "Connect" button, the "Remote Service" 
status does not change to OK. The  icon is still visible.

Cause: In the initial connection phase to the Remote Service, configuration data is set up or 
read and, changed, if required. A Remote Service connection cannot be established successfully 
if problems occur here.

Measure: Restart the PMC and repeat the steps until the connection is established. If the prob-
lem persists, the PMC has to be reinstalled. Please contact the Heidelberg service if this is the 
case.

The connection cannot be established: After clicking on the "Connect" button, the "Secure Connec-
tion" status does not change to OK. The  icon is still visible.

Cause: In the initial connection phase the PMC tries to establish a secure connection to Remote 
Service Heidelberg. If there are any problems with this, a secure connection cannot be made. 
This may be due to errors in the Remote Service Administration settings or access problems to 
the remote service (firewall, Proxy, network).

Measure: Please check the technical requirements of the connection as follows:

· Internet settings: The "www.heidelberg.com" URL must be accessible via Internet 
Explorer.

· Firewall: Remote port 443 (outgoing) must be opened in the firewall.

· The Remote Service Server must be accessible from the PMC:

Test 1: Execute via the command line "ping 194.31.235.38". If there is a reply, there is a physical 
connection to the Remote Service Server.
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Test 2: Run the following command line: "ping heires-device.heidelberg.com". The network 
name resolution functions correctly if there is a response.

Test 3: Use a browser to call up the URL https://heires-device.heidelberg.com:443. The mes-
sage that the security certificate for this website is not trusted can be ignored. Continue loading 
the website. The following message should now appear in the browser: "The website has 
declined to display this web page". In this case, a connection from this computer to the 
Remote Service is possible.

• Administration of the Remote Service in the PMC: Your administrative data must be complete 
and correct, there must not be any red crosses. Your details for Proxy and Port must also be cor-
rect.

• License: A License Server must be reachable. Please check the License Server. Is the computer 
switched on? Is the License Manager running? Is LIS installed? 

• Local Remote Service Client: Check in Windows Task Manager (with the option "Show pro-
cesses from all users" enabled) if the processes "ServiceAgentControlStart.exe" and "qsa-
Main.exe" are running.

If the problem persists, please contact the Heidelberg service.

When a Remote Service connection is available, the "Remote Service" status changes from the icon 
 to the icon .

�

�

Cause: The service ServiceAgentControlStart.exe or qsaMain.exe is no longer running (refer to 
"Local Remote Service Client" above).

Measure: Please check the technical requirements of the connection as described above. A 
Remote Service connection can only be established successfully when the PMC was restarted 
("Program > Restart"). If the problem persists, please contact the Heidelberg service.

Note: A system crash may leave the configuration data in a defective state. This may lead 
to the Remote Service services not starting properly or to being terminated immediately 
after starting. The Remote service start configuration should be restored, to do this, proceed 
as follows:

1. Exit the PMC.

2. Delete all current data of the day in "%HD_STD_SERVICE%\Remote Service\config\etc".

3. Delete the directory "%HD_STD_SERVICE%\Remote Service\config\pers".

4. Restart the PMC.

5. Repeat the steps for establishing a connection.

When a Remote Service connection is available, the "Secure connection" status changes from the 
icon  to the icon .

Cause: The connection to the Remote Service Server has been interrupted.
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Measure: Please check the technical requirements of the connection as described above. A 
Remote Service connection can only be established successfully when the PMC was restarted 
("Program > Restart").

The connection cannot be established: The "License Server" status does not change from the icon 
 to the icon .

Cause: A connection to a License Server cannot be established.

Measure: Please check the technical requirements of the connection as described above.

Connection test

The connection test fails: The  icon appears next to "Check Connection".

Cause: Settings are missing or incorrect. You can find further details in the text displayed in the 
main area, if applicable.

Measure: Please check the settings and the License Server.

The connection test fails: The  icon appears next to "Sending request".

Cause: The query file was not created properly or sending the file to the Heidelberg Remote Ser-
vice failed. You can find further details in the text displayed in the main area, if applicable.

Measure: Please check your connection to the Heidelberg Remote Service.

The connection test fails: The  icon appears next to "Waiting for reply".

Cause: No reply was received from the Prinect Service Center. After 90 seconds you will receive 
a warning, after 5 minutes the operation will be canceled. You can find further details in the text 
displayed in the main area, if applicable.

Measure: Please check your connection to the Heidelberg Remote Service.

The connection test fails: The  icon appears next to "Download test package".

Cause: The test package could not be downloaded from the Prinect Service Center. You can find 
further details in the text displayed in the main area or in "Extras > Data Transfers > Log", if 
applicable.

Measure: Delete the queue in "Extras > Data Transfers > Uploads/Downloads" with the  but-
ton. Please also check your firewall settings.

The connection test fails: The  icon appears next to "Importing test package".

Cause: The package could not or only partially be imported into the PMC Repository.

Measure: The measures to be taken will be in the displayed text.
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Software Update

Computer Maintenance

A computer that is not part of the system cannot be contacted: In the navigation area in front of the 
computer name the  icon appears. In the navigation area behind the computer name, the  
icon appears. In the tab of the main area, the  icon appears.

Cause: The PMC cannot access a computer that is not part of the system.

Measure: Ensure that the computer is switched on and that it has a connection to the network.

A computer that is part of the system cannot be contacted: In the navigation area in front of the com-
puter name, the  icon appears. In the navigation area behind the computer name, the  icon 
appears. In the tab of the main area, the  icon appears.

Cause: The PMC cannot access a computer within the system.

Measure: Ensure that the computer is switched on and that it has a connection to the network.

A computer does not change its status from "orange"  to "green" .

Cause: The status "orange" of a computer is displayed until the PMC has recognized its license 
data and its position in the system structure (not associated with a system or associated with a 
system). This operation usually takes up to ten seconds. Then the status will change to "green". 
If the PMC does not receive a reply, the status will not change to "green". If the query takes too 
long, the status changes from "orange" to "red" .

Measure: Now restart the computer concerned.

Data Transfer

There are no items in the list of update packages. The message "Update downloads are not currently 
cleared by Heidelberg" appears.

Measure: Please contact the Heidelberg service.

There are no items in the list of update packages. The following message appears: "The identity check 
for this installation could not be completed successfully".

Measure: Please contact the Heidelberg service.

There are no items in the list of update packages. The following message appears: "Heidelberg is cur-
rently unable to process queries for technical reasons. This problem will be corrected shortly".

Measure: Restart the manual search for update package later. If the problem persists, please 
contact the Heidelberg service.

In one row of the "Loaded Software Updates" window, the icon  appears.

Cause: Heidelberg has recalled this update. The update was stopped and is not offered as a 
potential update any more. It is still visible in the "Loaded Software Updates" window.

Measure: You do not need to take any action.
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In one row of the "Loaded Software Updates" window, the icon  appears.

Cause: This package is no longer required and can be deleted. These are packages for which a 
product is not installed, and whose master version is earlier than the installed master version of 
the product. You can press the button "Delete updates no longer needed" to delete such pack-
ages from the PMC Repository to free up hard disk space.

Measure: You do not need to take any action.

Installing the Update Packages

The installation fails. The update package in question is not yet available in the list of update pack-
ages.

Cause: There may be various reasons why the installation has failed.

Measure: Restart the computer on which you wanted to carry out an update and restart the 
installation.

Installation of an update package set was canceled manually. Potential cross dependencies could not 
be considered yet. This may, for example, cause the Workflow System to run erroneously.

Cause: When an installation is aborted, all packages already installed remain installed. The 
package currently being installed will finish installing. All packages not yet installed will not be 
installed.

Measure: The package set was split; already installed packages are no longer offered. In the list 
of update packages, select those update packages you wanted to install before cancelling. Click 
on the "Start Installation" button again.
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PMC Reboot Mode

In a customer's network, the PMC works as a server; only one instance of the PMC application may 
be running. We recommend installing the PMC on a dedicated server where none of the Prinect prod-
ucts to be updated is installed. The reason for this is that some update installations may require a 
restart and the PMC must not be shut down while it is running. If it cannot run on a dedicated server, 
some precautionary measures must be taken in the event of a restart.

This section describes a potential situation where software components to be updated with 
Prinect Remote Update are also installed on the PMC server. 

In this event, the situation may arise that the installer of an update package expects a restart. If it is 
impossible to quit the PMC immediately because other software updates are still in progress, reboot-
ing the PMC server has to be deferred until these processes are terminated. You should perform the 
required restart afterwards to ensure that the update concerned and all of the other updates associ-
ated with cross dependencies continue to function together and, future updates can be applied to a 
functional version. 

If this event occurs, you will see the following on the user interface:

• The caption "Software update not possible!" appears in the main window of the "Software 
Update" view of a computer or update group, and a respective message prompts you to close 
the view.

• To the right of "Software Update", the button "Maintenance" appears in the view bar.

• In the "Maintenance" view, a message appears which computer must be restarted.

Cause: The computer has to be rebooted, but other updates are still running.

Measure: Wait until all software updates have been completed, and then reboot the computer.
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Maintenance Mode

Software updates are also provided for the PMC. These updates are a prerequisite for working with 
the PMC.

When the maintenance mode is activated, you will see the following on the user interface:

• The caption "Software update not possible!" appears in the main window of the "Software 
Update" view of a computer or update group, and a respective message prompts you to perform 
the PMC update.

• To the right of "Software Update", the button "Maintenance" appears in the view bar.

• In the "Maintenance" view, you see a description how to update the PMC.

Automatic License Import

Explanation of the following possible errors: 

• Error while importing the LUX file: This means the structure of the LUX file is defective, or con-
tents are missing.

• The License Server could not be found: An attempt is made for 7 days to import the LUX file. 
Make sure the License Server with the correct Dongle Number (LSN) is switched on, that the ser-
vices of the License Server are running, and that the License Server has connected with the 
PMC.

• Error during product information import: One reason could be a faulty entry in the LUX file (sec-
tion LicFile).

• Error during license key export: One reason could be a faulty entry in the LUX file (format-1: sec-
tion LicEntry; format-2: section LicSite).

Another reason could be that other product data is already present on the License Server (the 
information will not be overwritten) and that, as a result, the license does not match this prod-
uct. To remedy this, delete the obsolete product data on the License Server and import the LUX 
file again.
Prinect Maintenance Center  –  User’s Guide 71





Question and Answers

Question and Answers
FAQs

The network-based Prinect Remote Update quickly and efficiently provides the current Prinect 
updates for installation on the customer's network automatically.

Here you can find the answers to any questions you may have about this service from Heidelberg Sys-
tems service.

What are the installation requirements?

• The PMC software must not be installed on a computer to which a Heidelberg platesetter is con-
nected and on which the corresponding software is installed.

• If possible, we recommend installing the PMC software on a computer without any other Prinect 
products installed. When updating Prinect software you may have to reboot the computer. At the 
PMC computer, you have to this this manually.

• If possible, the PMC server should be running permanently so that update packages can be 
downloaded in the background.

• The data transfer must be enabled initially.

Safety-related actions in the customer's network (e.g. accounts for proxy authentication) should be 
carried out after consultation with Heidelberg if necessary.

What are the differences between a conventional update and the network-based Prinect 
Remote Update?

• The network-based Prinect Remote Update ensures that all of the required current hotfixes and 
updates for Prinect products are automatically provided on the customer's network. This is done 
in the background without affecting the current applications.

• The previously required search for updates in the Download Center has been omitted.

• The hotfixes and updates will arrive centrally on the customer's network in the Prinect Mainte-
nance Center (PMC). You can see at a single glance in the PMC if your Prinect Workflow system 
is receiving all the necessary updates.

• Heidelberg checks the type and number of required and suitable updates for you and provides 
you with suggestions which updates you should install.

• The PMC provides the Web User Interface, controls the update installation procedures and holds 
the central Software Repository containing the update packages ready for installation.

• You decide when to perform the update and start the process in the Prinect Maintenance Center.
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How does the Prinect Remote Update benefit the customer? 

• The software packages are installed following your approval, i.e. you control the process based 
on your needs.

• Downtimes to install hotfixes and updates can be scheduled – you can perform the installation 
when it is most convenient for you, including overnight.

• Fast and efficient provision of hotfixes and updates is the key to a trouble-free production envi-
ronment in the entire workflow and a continually up-to-date Prinect Workflow System.

• The updates of all the Prinect products in the Prinect Workflow System are matched to each 
other. This results in higher productivity and availability for the system.

What are the Heidelberg requirements to the customer's IT infrastructure?

• Network connection to the Prinect computers (IP addresses in IPV4 format). 

• Prinect computers and PMC should preferably be located within a common subnet with Multi-
cast routing.

• Network connection to the internet for the PMC computer (for the Remote Service connection 
and for downloading the update packages).

• User account with Administrator privileges on the PMC computer (e.g. Domain Account as mem-
ber of the local administrator group; required for logging in at the PMC Server via Browser); 
security measures (e.g. firewalls, virus protection, etc.).

What type of data is transferred to Heidelberg to determine the updates?

• Operational data

· Company name

· Street

· City

· Country

• Several Prinect Workflow System data to identify the required updates. You can find more details 
in the product documentation.

• Data collection can be disabled at any time from the Prinect Maintenance Center on the cus-
tomer's network. In this case, none of the computers managed by the PMC in the customer's 
network participate in the automatic update.
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Where can I check whether the data transfer is enabled on the Prinect Maintenance Center?

• The user can find information on whether the data transfer is enabled in the "Administration > 
HEIDELBERG connection" view.

• This is also where the data transfer can be disabled at any time in the Prinect Maintenance Cen-
ter.

Can users access the Internet via the Prinect Maintenance Center?

• No.

• The connections between the Prinect Maintenance Center and the Heidelberg network are pre-
configured and can only be used for this application with the default address.

How secure is Prinect Remote Update?

• The network-based Prinect Remote Update from Heidelberg uses state-of-the-art technology to 
provide the most convenient and more secure means of communication via the Internet.

• Just the same, it is important, and Heidelberg explicitly recommends, that the users configure 
the Internet access according to their own security criteria.

Do I have to sign a service contract? 

• No special service contract is required during the statute of limitations for warranty claims and 
during the term of the Systemservice36plus service program.

• In all other cases, you must sign a Prinect software maintenance contract for all of the Prinect 
products in your workflow. For detailed information, please contact your Heidelberg Sales and 
Service Unit.
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